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LICENSE AGREEMENT
For

“BACnet Gateway for VRF System”

IMPORTANT-READ CAREFULLY
This “BACnet GATEWAY for VRF SYSTEM” License Agreement (“LICENSE AGREEMENT”) is a legal agreement between 
you and Fujitsu General Limited (“FGL”) for the use of VRF BACnet GATEWAY products consisting of computer software and 
online, electronic and/or printed documentation (collectively “SOFTWARE PRODUCT” or “SOFTWARE”). By installing, copy-
ing, or otherwise using the SOFTWARE PRODUCT, you accept to be bound by all of the terms and conditions of this LICENSE 
AGREEMENT. If you do not agree to any of the terms and conditions of this LICENSE AGREEMENT, you shall not use the 
SOFTWARE PRODUCT and shall promptly return the SOFTWARE PRODUCT to the place where you have obtained it.

COPYRIGHT AND OWNERSHIP.111
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties as well as other intellec-
tual property laws and treaties. The SOFTWARE PRODUCT is licensed to you, not sold. FGL owns the title, copyright, 
and other intellectual property rights in the SOFTWARE PRODUCT.

GRANT OF LICENSE.222
FGL hereby grants you the limited, non-exclusive and non-transferable rights to use the SOFTWARE PRODUCT only for 
the purpose of controlling the VRF air-conditioning system products (VRF) provided you comply with all terms and condi-
tions of this LICENSE AGREEMENT. You may copy the SOFTWARE PRODUCT solely for backup or archival purposes.

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.333
LIMITATIONS ON REVERSE ENGINEERING, DECOMPILATION, AND DISASSEMBLY.((((
You shall not modify, alter, reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT. You shall not 
alter or remove any copyright, trademark or other proprietary notice of FGL from the SOFTWARE PRODUCT.

NO RENTAL, LEASE AND TRANSFER.((((
You shall not rent, lease or transfer the SOFTWARE PRODUCT to any person and/or entity (-ies).

TERMINATION.((((
Without prejudice to any other rights, FGL may terminate this LICENSE AGREEMENT if you fail to comply with any 
terms and conditions of this LICENSE AGREEMENT. In such an event, you shall promptly return all originals and 
copies of the SOFTWARE PRODUCT to FGL.

INSTALLATION AND USE OF SOFTWARE PRODUCT.444
You may install and use the enclosed SOFTWARE PRODUCT on a single computer under one of the operating environ-
ment identified in the documentation accompanying the SOFTWARE. You shall not network the SOFTWARE or otherwise 
use it on more than one computer at the same time. The infrastructure necessary to use the SOFTWARE PRODUCT (PC, 
accessories, etc.) shall be prepared separately by you. 

NO WARRANTY.555
FGL EXPRESSLY DISCLAIMS ANY WARRANTY FOR THE SOFTWARE PRODUCT. THE SOFTWARE PRODUCT IS 
PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITH-
OUT LIMITATION, STATUTORY WARRANTIES, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR 
NON-INFRINGEMENT OF THIRD PARTY’S RIGHTS. THE ENTIRE RISKS ARISING OUT OF USE OR PERFORMANCE 
OF THE SOFTWARE PRODUCT REMAIN WITH YOU. HOWEVER, IF YOU NOTIFY FGL OF PHYSICAL DEFECT OF 
THE MEDIA CONTAINING SOFTWARE WITHIN (90) DAYS FOLLOWING YOUR RECEIPT OF THE SOFTWARE PROD-
UCT, FGL WILL REPLACE THE DEFECTIVE MEDIA WITH NEW MEDIA.
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LIMITATION OF LIABILITY.666
IN NO EVENT SHALL FGL BE LIABLE TO YOU OR TO ANY THIRD PARTY FOR ANY DIRECT OR INDIRECT DAMAG-
ES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFIT, BUSINESS 
INTERRUPTION OR LOSS OF BUSINESS INFORMATION, DAMAGES ARISING OUT OF DATA OR INFORMATION 
DERIVED FROM OR BASED ON THE ELECTRICITY CHARGE APPORTIONMENT FUNCTION IN THE SOFTWARE 
OR ANY OTHER PECUNIARY LOSS), ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE , EVEN IF 
FGL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

ENTIRE AGREEMENT.777
This LICENSE AGREEMENT (including any addendum or amendment to this LICENSE AGREEMENT included with 
the SOFTWARE PRODUCT) is the entire agreement between you and FGL relating to the SOFTWARE PRODUCT and 
supersedes all prior contemporaneous oral or written communications, proposals and representations with respect to the 
SOFTWARE PRODUCT or any other subject covered by this LICENSE AGREEMENT.

INDEMNITY.888
You agree to indemnify and hold FGL, and its subsidiaries, affiliates, officers, agents, co-branders or other partners, and 
employees, harmless from any damage, claim or demand, including without limitation reasonable attorneys’ fees, made 
by any third party due to or arising out of use of the SOFTWARE PRODUCT.

GOVERNING LAW AND JURISDICTION.999
This LICENSE AGREEMENT is governed by the laws of JAPAN. You and FGL hereby irrevocably consent to the exclu-
sive jurisdiction and venue in the Tokyo District Court and other higher courts having jurisdiction in Japan for the settle-
ment of disputes arising under or in connection with this LICENSE AGREEMENT.
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Usage Precautions111
Precautions When Using the BACnet Gateway1111

Please read and agree to the LICENSE AGREEMENT FOR “BACnet Gateway” at the beginning 111
of this manual before using the BACnet Gateway. 

Please confirm that the PC for the BACnet Gateway meets the operating condition of the “Product 222
Specifications” described in the Appendix of this manual.

Please read and fully understand this manual before using the BACnet Gateway. 333

Be careful not to shutdown or turn off the power supply of the PC or unplug its transmission adap-444
tor. Do not terminate the BACnet Gateway  program unless necessary. Otherwise, normal opera-
tion of the BACnet Gateway may not be performed.

To ensure continuous normal operation of this software,set the PC so that it would not go into an 555
energy saving mode such as standby mode, sleep mode or execute hibernation. If the PC goes 
into a standby, sleep mode or execute hibernation, this software may not function properly. The 
method for setting the energy saving or hibernation of the PC depends on the Windows versions. 
For Windows XP,right click on the desktop and open the "Display properties", select "Screen 
Saver"tab and click on the "Power..." button. When the "Power Options Properties" appears, 
select the "Power schernes" to "Always On". Also, select the "Hibernate"tab and un- check the 
"Enable hibernation".

The CD for this software and the software protection key (WIBU-KEY) will not be reissued. Keep 666
and handle them with great care after installing.

BACnet Gateway programs perform schedules, operation recording and electricity apportionment 777
data control based on date and time set in the personal computer. Adjust date and time periodi-
cally and by a small amount. Changing date and time may affect the functions listed above.	
When the date/time of the PC running BACnet Gateway is adjusted to roll back in time, the data 
collected for the electricity charge apportionment for that period will be deleted and be newly col-
lected. When the date/time is adjusted to roll forward in time, there will be no data for that period. 
Such cases will result in incorrect calculation results for the electricity charge apportionment so 
the user should be careful when adjusting date/time for the PC.

When program execution environment of Windows is corrupted or abnormal, or if other software 888
is installed or running on the same PC, operation of BACnet Gateway may be interfered and may 
not install or run properly. It is usually extremely difficult to detect such conditions, if it occurs. It is 
recommended that BACnet Gateway be installed on a new PC, dedicated for the use of BACnet 
Gateway. 

BACnet Gateway product is provided with software, drivers, components listed below. If the same 999
kind of software, drivers, components with different version is installed on the same PC, BACnet 
Gateway may not install or run properly.

Microsoft(((( ® SQL Server® 2005
OpenLDV (U10 USB Network Interface driver)((((
Microsoft(((( ® Visual C++ 2005 SP1 Redistributable
WIBU-KEY driver((((
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How To Use This Manual222
Manual Composition2222

This manual is composed of 5 sections.
Introduction●●
Installation●●
Settings●●
Operation●●
Appendix●●

Before installing the software, read the Introduction first and check the Overview of the BACnet Gateway 
and the notes and cautions.

When installing the BACnet Gateway to the PC, read the Installation and Settings sections. Complete in-
stallation to the PC in accordance with the procedure described.

When performing operations related to various functions of the BACnet Gateway after installation, refer to 
the relevant parts of the operation section.

The Appendix is made up of product specifications, error code table, and FAQ. Read them as required.

Interface Specification document is also available and should be referred to along with this manual.
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3333 Features

=

VRF System 0

BACnet® Operator
Workstation (B-OWS)

VRF System 1

.

.

.

.
(Max. 4 VRF Systems)

Echelon®U10 
USB netwwork 
interface (field 
supply)

PC Hardware
(field supply)

BACnet®/IP

BACnet® Gateway
(UTY-ABGX)

CD-ROM
(Software)

Software
protection key

USB port
LAN port

Lighting
facilities

Security
system

Automatic fire
alarm interface

Ventilation
system

BACnet® Gateway for
each system

VRF network USB Ethernet

Echelon®U10 
USB netwwork 
interface (field 
supply)

Echelon®U10 
USB netwwork 
interface (field 
supply)

Echelon®U10 
USB netwwork 
interface (field 
supply)

BACnet Specification of UTY-ABGX
•ANSI / ASHRAE Standards 135-2004
•BACnet Application Specific Controller (B-ASC)
•BACnet / IP over Ethernet

The maximum number of connecting systems

VRF System 4 systems

For the numbers of the Units that can connect with one 
VRF System, Indoor and Outdoor Units are up to 400 
units and up to 100 units respectively.

VRF System Address: **
The numbers from 0 to 3, which are assigned to each VRF System in the BACnet Gateway. 
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Materials necessary at installation
WIBU-KEY (packed together with product)●●
U10 USB Network Interface (adaptor with connection to VRF network work finished)●●
Administrator ID and password (arbitrarily decided by the user. 2 byte characters cannot be used.)●●
BACnet Gateway setup CD (For details, see the next page.)●●
IP address●●

When number of USB ports for WIBU-KEY and U10 USB Network Interface are 
insufficient;

USB hub●●

Setup CD configuration (Reference)

ABGX00010000

Manual BACnet Gateway Manual.pdf
(PDF file for this manual)
+Interface Specification.pdf

LicenseAgreement LicenseAgreement.pdf

ReadMeFirst.txt
Read before installing the software application.

ISSetupPrerequisites

Tools 153-0212-01A_OpenLDV340.exeOpenLDV

Driver for U10 USB Network Interface
When the Driver for U10 USB Network Interface is installed, execute it.

vcredist_x86_SP1_ATL_English.exeVC_SP1

Runtime files for VisualC++2005
It is usually installed automatically when BACnet Gateway is installed.

WkRuntime.exeWibuKey

Driver for WIBU-KEY
This software is necessary to use WIBU-KEY
It is usually installed automatically when BACnet Gateway is installed to 
the PC.
When the driver for WIBU-KEY is installed manually, execute it.

setup.exe
Install the BACnet Gateway to the PC.
Execute the setup.exe to install.



5.	 Installation

Installation



12
Copyright© 2010 Fujitsu General Limited. All rights reserved.

In
st

al
la

tio
n

Installation555
This section describes the procedure when installing the BACnet Gateway software to the PC which con-
nects directly to the VRF network. The PC communicates directly with the indoor and outdoor units. 

The PC and VRF network are connected by a Transmission Adaptor (U10 USB Network Interface).

This section also describes how to uninstall the software when BACnet Gateway software becomes unnec-
essary and also, how to reinstall the installed software due to software upgrading or other reasons.
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Installation Flow5555

Installation/Setting Flow

5-2	 Hardware Installation

5-4	 Software Installation

Microsoft® .NET Framework 2.0
Microsoft® SQL Server® 2005

Microsoft® Visual C++ 2005 SP1 Redistributable
BACnet Gateway
WIBU-KEY Setup

6	 Basic Setting

5-3	 Regional Setting

 WARNING!
BACnet Gateway is tested to install and operate under new Windows environment. When 
program executional environment of Windows is corrupted or abnormal, or other softwares 
that interfere with the operation of BACnet Gateway is installed or running, BACnet Gateway 
may not install or run properly. It is usually extremely difficult to detect such conditions, if it oc-
curs.

BACnet Gateway product is provided with softwares, drivers, components listed below. If the 
same kind of softwares, drivers, components with different version is installed on the same 
PC, BACnet Gateway may not install or run properly.

Microsoft(((( ® SQL Server® 2005
Open LDV (U10 USB Network Interface driver) ((((
Microsoft(((( ® Visual C++ 2005 SP1 Redistributable
WIBU-KEY-driver((((

Do not insert U10 USB network interface adaptor to the USB slot of the PC BEFORE its driver 
is installed. 

Do not turn on the power of indoor/outdoor units until all installation work is completed.
Do not insert WIBU-KEY to the USB slot of the PC until instructed. 5
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Hardware Installation (Transmission Adaptor)5555

555555Transmission Adaptor Installation

UTY-ABGX
BACnet Gateway

Transmission Adaptor
(U10 USB Network Interface)

VRF System 3

VRF System 2

VRF System 1

VRF System 0

USB cable

The BACnet Gateway can connect up to 4 VRF Systems. Since 1 Transmission Adaptor connects to 1 
system, up to 4 Transmission Adaptors are connected.

Following chart shows the detail of the U10 USB Network Interface Adaptor. These adaptors are not includ-
ed in the BACnet Gateway product and must be procured in advance. 

Name & Shapes Q’ty Remark

Transmission Adaptor (U10 USB Network Interface 
-TP/FT-10 Channel)

(Field Supply)

Procure the necessary number 
in accordance with the number 
of connection systems.

Model : 75010R
(Echelon® Corporation)
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Installing U10 USB Network Interface Adaptor
To use this product, turn on the power of the PC and install necessary drivers/software for this product (BE-
FORE connecting it to any USB port ), following the ***QUICK START*** enclosed with this product.

When using multiple U10 USB Network Interface adaptors, confirm in advance, which U10 USB 
Network Interface adaptor connects to which VRF Network (Attach labels to the U10 USB Network 
Interface adaptors If possible). These information will become necessary during the setup procedure 
of BACnet Gateway (You will be required to specify which U10 USB Network Interface adaptor corre-
sponds to which VRF network). 

1

2

3
4

VRF0

LON1

LON2

LON3

LON4

VRF1
VRF2

VRF3

Keeping a record of a table such as shown below is recommended.

LON No. Adaptor No. VRF System No.

LON1 Adaptor 1 VRF 0

LON2 Adaptor 2 VRF 1

LON3 Adaptor 3 VRF 2

LON4 Adaptor 4 VRF 3

Note. “LONx” is used to identify U10 USB Network Interface adaptor. LON numbers are given in the or-
der they are inserted to a PC for the first time and basically, never changes, even if you change USB slot 
afterwards. 

Connect the U10 USB Network Interface adaptor to the personal computer USB port.
When there are multiple U10 USB Network Interface adaptors, connect each U10 USB Network Inter-
face adaptor in the order of its LON number. 
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Wiring and Turning on the Units Power555555

Once the wiring has been installed, the power can be turned on. Follow the procedure below for turning on 
the power.

Connect VRF network cables to the corresponding U10 USB Network Interface adaptors. 
Turn on the power for all connected indoor units.
Turn on the power for all connected outdoor units.

Make sure that USB equipment (USB hub, etc.) that this product is connected to, is not overloaded (power sup-
plied thru the interface does not exceeds the maximum limit).

Note

Turn on the power for BACnet Gateway PC, if it is not yet turned on.
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Regional Setting5555

Windows555555 ® XP

Open the regional setting screen by sequentially selecting the menus as follows:
“start” → “Control Panel” → “Date, Time, Language, and Regional Options” 

When the control panel display format is Classic View, select the menus in the following order:●●
“start” → “Control Panel” → “Regional and Language Options”

Note

Select English (United Kingdom) at the Standard and formats area of the Regional Options tab.
 Select English (United Kingdom) at the Language for non-Unicode programs of the Advanced tab.

2

4

[Regional Options tab]

3

[Advanced tab]

Do not change the settings clicking the [Customize...] button. Set the settings as follows, if by chance, 
the current settings differs.
[Numbers]........Decimal symbol: “.” (dot)
[Time]...............Time separator: “:” (colon)
[Date]...............Date separator: “/” (slash)

Note

Click the [OK] button.
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Windows Vista555555 ®

Regional option��

Open the regional setting screen by sequentially selecting the menus as follows:
“start” → “Control Panel” →  → 

Select English (United Kingdom) at the Current format area of the Formats tab.

2

Select Administrative tab and click [Change system locale...] in the Language for non-Unicode pro-
grams area.
If security confirmation screen appears, press “Continue”.

3

5
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Select English (United Kingdom) for the Current system locale in the Regional and Language Settings 
and click [OK].

4

Do not change the settings clicking the [Customize...] button. Set the settings as follows, if by chance, 
the current settings differs.
[Numbers]........Decimal symbol:”.”(dot)
[Time]...............Time separator. “:”(colon)
[Date]...............Date separator:”/”(slash)

Note

Click [OK].5
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Software Installation5555
The following software is installed here.

Microsoft●● ® .NET Framework 2.0
Microsoft●● ® SQL Server® 2005
Microsoft●● ® Visual C++ 2005 SP1 Redistributable (Package ATL Security Update)
BACnet Gateway●●
WIBU-KEY driver●●

Before starting the installation of this product, check each of the followings. 
Install Adobe Reader (Ver. 9.0 or later) prior to the installation. (Adobe Reader does not come with this ●●
product).
Have the installation CD of the Windows version (Windows●● ® XP or Windows Vista®) used for the PC 
ready. 

Remove all program as described in “5-5 Software Uninstallation” , if you have the same or previous ●●
version of BACnet Gateway.
Do NOT insert WIBU-KEY (Software protection key) enclosed with this product to the PC until product ●●
installation is completed.
You are required to login to the computer as Administrator (or equivalent) to the PC to install this prod-●●
uct. (Enter the ID with single-byte characters.)
Stop all running programs before you start the installation.●●
If Anti-Virus software product is installed, temporarily disable the software during the installation of this ●●
product.

Execute setup.exe in the root folder on the BACnet Gateway setup CD.
Microsoft●● ® .NET Framework 2.0

.NET Framework 2.0 is installed automatically if it is not already installed.
Microsoft●● ® SQL Server® 2005

Microsoft® SQL Server® 2005 is installed automatically if it is not already installed.
Microsoft●● ® Visual C++ 2005 SP1 Redistributable (Package ATL Security Update)

Microsoft® Visual C++ 2005 SP1 Redistributable is installed automatically if it is not already installed.
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Click the [Install] button.

2

Click the [Yes] button.

3

BACnet Gateway●●

Install BACnet Gateway. Click the [Next] button.

4
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If the BACnet Gateway end user licensing agreement is displayed, confirm the contents.5
If you can agree to the terms of the licensing agreement, check “I accept the terms in the license 
agreement” and click the [Next] button.

5
5

Specify the installation destination folder and click the [Next] button.

(To change the installation destination folder, click the [Change] button and select the folder to be in-
stalled.)

6
If the installation setting contents are correct, click the [Install] button.

7
Installation starts.
The necessary drivers are also installed at the same time. 
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WIBU-KEY driver●●

A description of WIBU-KEY Setup is displayed. Confirm the contents.
Click the [Next] button.



Select the language.
Check the desired language.

Click the [Next] button.




When the screen to specify the installation destination folder is displayed, specify the installation desti-
nation folder and click the [Next] button.





24
Copyright© 2010 Fujitsu General Limited. All rights reserved.

In
st

al
la

tio
n

Click the [YES] button.



The WIBU-KEY components selection screen is displayed.
Uncheck all the checkboxes and click the [Next] button.


If the WIBU-KEY driver installation contents are displayed, confirm the contents and click the [Next] 
button. 


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Installation starts.
When [Next] button is enabled, click the [Next] button.



WIBU-KEY Setup is complete.
Uncheck the checkbox and click the [Finish] button.



WIBU-KEY Setup was successful.
Click the [OK] button.


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If this screen is displayed, installation of the BACnet Gateway for VRF System to the PC is complete.
Click the [Finish] button



After the end of installation, reboot the PC.
Click the [Yes] button.


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Software Uninstallation5555
When uninstalling the software from PC, follow the procedures shown below.

5-5-1 	 BACnet Gateway Uninstallation

5-5-2	 WIBU-KEY Driver Uninstallation

5-5-3	 Microsoft® SQL Server® 2005 Uninstallation

5-5-4	 Microsoft® SQL Server® Native Client Uninstallation

When you intend to reinstall BACnet Gateway later, export "All Data" at this point.
→8-3-3   All Data Export
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BACnet Gateway Uninstallation555555

When you need to keep the data for later use, export the data before uninstalling the BACnet Gate-●●
way.

Write all the data by exporting.      → 8-3  Data Import/Export

Note

Select the menu items in order of [start]→[Control Panel]→[Add or Remove Programs].
Select the “BACnet Gateway for VRF System (UTY-ABGX)”.
Click the [Remove] button.

32

When the [Yes] button is clicked, uninstallation begins.

4
When the screen displaying the uninstallation process closes, uninstallation is complete.5
Close the “Add or Remove Programs” screen by clicking the [×] at the top right-hand corner of the 
screen.
A folder named the BACnet Gateway remains in the folder designated the BACnet Gateway installation folder at **
installation even though uninstallation is performed.
There is no problem even if this folder remains as is, but it doesn’t matter if the folder is deleted.
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WIBU-KEY Driver Uninstallation555555

Execute only when you know for certain that the WIBU-KEY driver is not used by programs other than the 
BACnet Gateway.
If unknown, do not uninstall the WIBU-KEY driver
Remove WIBU-KEY from the PC before uninstalling it.

Select the menu items in order of [start]→[Control Panel]→[Add or Remove Programs].
Select “WIBU-KEY Setup (WIBU-KEY Remove)”.
Click the [Change/Remove] button.

32

Click the [OK] button.

4
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Check "Ignore, Setup will replace file at system startup (reboot required)."5

6

5

Click the [OK] button.
When this screen is displayed, uninstallation of the WIBU-KEY driver is  complete.
Click the [Finish] button.

7
Close the “Add or Remove Programs” screen by clicking the [x] at the top right-hand corner of the 
screen.
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Microsoft555555 ® SQL Server® 2005 Uninstallation

Execute only when you know for certain that Microsoft® SQL Server® 2005 is not used by programs other 
than the BACnet Gateway.
If unknown, do not uninstall the program.

Select the menu items in order of [start]→[Control Panel]→[Add or Remove Programs].
Select “Microsoft SQL Server 2005”.
Click the [Remove] button.

32

The components selection screen is displayed.
Check “Remove SQL Server 2005 Instance components”.
Select “SQLEXPRESS: Database Engine” of the “Select an instance item”.

4

5
Click the [Next] button.5

When another instance exists at the “Select an instance” item or when an item exists at” Remove SQL Server **
2005 common components”, it may be possible that other Microsoft® SQL Server® products are installed. Be 
careful not to delete them by mistake. In addition, in this case, do not perform the “Microsoft® SQL Server® Native 
Client” uninstallation on the next page.

Note
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Click the [Finish] button.
When the screen displaying the uninstallation process closes, uninstallation is complete.
When there were items other than those at the processing of 4 on the screen of 4, do not uninstall 
the “Microsoft® SQL Server® Native Client”.

6
System Configuration Check is implemented automatically. When ended, the screen automatically 
closes.
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Setup Progress screen is displayed. When ended, the screen automatically closes.

Close the “Add or Remove Programs” screen by clicking the [×] at the top right-hand corner of the 
screen.
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Microsoft555555 ® SQL Server® Native Client Uninstallation

Execute only when you know for certain that Microsoft® SQl Server® 2005 is not used by programs other 
than the BACnet Gateway.
When unknown, do not execute.
In addition, do not execute when Microsoft® SQL Server® products other than “Microsoft SQL Server 2005” 
are installed.

Select the menu items in order of [start]→[Control Panel]→[Add or Remove Programs].
Select “Microsoft SQL Server Native Client”.
Click the [Remove] button.

32

Click the [Yes] button.

4
When the screen displaying the uninstall process closes, uninstallation is complete.

Close the “Add or Remove Programs” screen by clicking the [×] at the top right-hand corner of the 5
screen.

When installing the BACnet Gateway, “Microsoft®.NET Framework 2.0” and “Microsoft® Visual C++ 
2005 SP 1 Redistributable” may be installed at the same time.
Since “Microsoft®.NET Framework 2.0” and “Microsoft® Visual C++ 2005 SP 1 Redistributable” may 
also be used by other programs, if it is uninstalled, the other programs may not run properly.
If not inconvenient, do not uninstall “Microsoft® .NET Framework 2.0”, and “Microsoft® Visual C++ 2005 
SP 1 Redistributable” and let it remain as is.

Note



6.	 Basic Settings
7.	 Electricity Charge Apportionment Setting

Settings
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Basic Settings666
In this section, the basic settings necessary before use in the PC are explained. The settings that are also 
necessary when equipment configuration changes are also explained here.
When starting the system for the first time after installation, make the settings in accordance with the flow 
described below. At the 2nd and subsequent starting, make the necessary settings in accordance with sub-
sequent paragraphs, as required.

When Starting for the First Time6666
When starting the BACnet Gateway for the first time, perform the settings in accordance with this flow.  

Setting for First Time Use●●

6-5 Unit Registration

CancelOK

Scanning range●●

Device confirmation●●

CancelOK

OK

CancelOK

6-4 Adaptor Setting

Transmission adaptor selection●●
Transmission Adaptor Name setting●●
Transmission line connection confirmation●●

Main screen BACnet Gateway program ends.  
(When Cancel is selected, Setting is stopped.
Setting must be repeated from the beginning.)

BACnet Gateway 
program ends.

(b)

CancelOK (a)

6-3 Selection of Unit Data Acquisition Method

To perform "Adaptor Setting"............................... (a)
To import backed up data.................................... (b)

6-2 Initial Setting

Items Which Can Be Arbitrarily Set●●

6-6 Description Property Setting
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Initial Setting6666
Makes any settings and changes necessary before operation.

When you want to reset Initial Setting, open the “Initial Setting” screen.
Select the menu items in order of [Setting]→[Initial setting] from the Menu bar.

1

Input or check each item of the screen shown below.
Always set “IP Address” and “Subnet Mask".
Change other items as required.

3

Click the [OK] button.
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Items Contents
IP Address Enter the IP address used in BACnet communications. (IPv4 only)

Subnet Mask Enter the subnet mask corresponding to the IP address used in 
BACnet communications.

Device Instance No. Enter the Instance No. of the local Device.

Device Object Name Enter the object name of the local Device. (Up to 50 ASCII charac-
ters)

Max_APDU_Length_Accepted Select the acceptable APDU length.
APDU_Timeout (m sec) Enter the APDU timeout time in milliseconds.
Number_of_APDU_Retries Select the number of retries when time out occurs.

APDU_Segment_Timeout (m sec) Enter the internal time at which APDU segment is resent, in milli-
seconds.

I-Am Service Broadcast Sending 
(at 60-second intervals)

Check when you want to send I-Am Service periodically. (60-second 
intervals)

Unconfirmed COV Notification Service 
Broadcast Sending

COV notification is sent by broadcast even when SubscribeCOV 
service is not subscribed. Refer to the interface specifications for 
the target object.
* Depending on the number of units and their status,large number 

of packets are sent.
Process ID Process ID used when sending COV notification.
Synch. VRF System Time to Time Synchroni-
zation/UTCT Time Synchronization.

Check if you want to send “system time setting” to VRF units when 
TimeSynchronization/UTCTimeSynchronization Service is received.

Register as Foreign Device with BBMD Check when you register as an external device to BBMD.
BBMD at IP Address BBMD IP address.
BBMD at UDP Socket BBMD UDP port No.

Selection of Unit Data Acquisition Method6666
This setting is performed only at first start settings.

To perform "6-4 Adaptor Setting" processing, select (a).
To import backed up data, select (b).

Click the [OK] button.

(a)
(b)
2
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Adaptor Setting6666
Sets the Device Name and confirms the Device State of the Transmission adaptor (U10 USB Network Inter-
face) that connects the BACnet Gateway.

When you want to reset Adaptor Setting, open the “Adaptor Setting” screen.
Select the menu items in order of [Setting]→[Adaptor setting] from the Menu bar.

1

The Adaptor Name can be set for easy identification by the user. Click the Adaptor Name you want to 
set and enter the text. (Default name: “AdaptorX”) 
Up to 20 characters (alphabet, numeric, and symbol) can be set. The Adaptor Name cannot be dupli-
cated. Only the connected adaptor can be set.

Usable device setting and confirmation are possible.

D
ev

ic
e

Name A usable devices list (LONx) or “Not Used” can be pulled down and selected.

Status

Displays the device status.
Ready The specified adaptor can be used.
Busy The specified adaptor is being used by another system.
Error The specified adaptor cannot be used.

(Blank) Not displayed when an adaptor is not connected.

Check

When the [Wink] button is clicked, the SVC lamp of the speci-
fied device lights (for approx. 2 second) and you can confirm 
which Transmission line the adaptor is connected to. (Only 
when the Device Status is Ready)

SVC Lamp

3

4

2

[OK]: 	 Saves the settings and ends setting work.
[Cancel]: 	Ends setting work without saving the settings. 

Adaptor Name is a name which can be arbitrarily set so that the user can easily identify connection of the 
Transmission adaptor (U10 USB Network Interface). (Default name: “AdaptorX”)
“Device Name” is a name automatically allocated on the network when a Transmission adaptor (U10 USB 
Network Interface) was connected. (Can be changed by LONx and the user)

Note
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Unit Registration6666
Scans by the network and detects and registers usable R.C. groups and outdoor units.
The units registered by scanning are managed by BACnet Gateway.

When you want to reset Unit Registration, open the “Unit Registration” screen.
Select the menu items in order of [Setting]→[Unit Registration] from the Menu bar.

1

Set the scan Targets.
Scan targets

Adaptor Name

Selects the name of the adaptor which is to perform scanning.
 (Name set at par. 6-4 Adaptor Setting)
Unit Registration is necessary for each adaptor.
When an adapter is set at a blank line, a blank line is added below it.
The same adapter can be set on multiple lines and different refrigerant system can also be 
specified.

Secure Reg.

Specifies by checkbox whether or not secure registration is to be performed when scanning
Checked: Secure registration (Recommended)  Not checked: No secure registration
When scanning is performed by secure registration, operation of the units is stopped.
When you do not want to stop operation, uncheck the checkbox.
See par. 11-1 No.4.

Ref. No.
Start When partially scanning, specify the start number of the refrigerant system by pull-

down menu or key input.   See par.11-1 No.8.

End When partially scanning, specify the end number of the refrigerant system by pull-
down menu or key input.

Device

Name Displays the name of the device used by the relevant network.

Status Displays the status of the device used by the relevant network.
Normal: “Ready”  Abnormal: “Error”  Not connected: “Blank”

Check

When the (a) [Wink] button is clicked, the SVC lamp of the Transmission adaptor 
used by the relevant network lights (for approx. 2 second) and connection of the se-
lected adaptor can be identified. (Effective only when the status of the Transmission 
adaptor is normal.)
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2

3

5

(a)

Description of screen

Click the [Start] button.
Click the [OK] button. (The following screen is displayed only when “Secure Reg” is checked.)

4
Starts scanning. (Disabled when there is no scanning target.)

The time required by scanning differs with the size of the system. Use the indicator displayed at (b) 
during scanning as a guideline.
While scanning is being performed, the [Stop] button (c) is displayed. To stop scanning, click this but-
ton.

All systems connected to one Transmission adaptor (U10 USB Network Interface) are stopped during 
scanning for secure reg.

Note

(b)

(c)

VRF network list display during scanning

When scan ends, “Done” is displayed at the progressive bar display.
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If the following message is displayed after scanning is completed, the necessary information cannot be 
acquired.
"Information was not acquired for some units. Perform unit  registration again."
In this case, always perform scan again to acquire all the necessary information. 
If advanced to next as is, normal operation will become impossible. 
Especially, if there is a unit for which information could not be acquired when electricity charge apportion-
ment is performed, the refrigerant system including that unit will not be handled by the electricity charge 
apportionment function. 
When these information missing units are included in “Unit Newly Detected”, since they are displayed in 
red characters, treat them as the index of refrigerant system specification when rescanning.

Note

Unit newly detected list:●●
After the end of scanning, displays the units 
newly detected.
At initial scanning, all the units are displayed. 
From the 2nd scanning, only the units newly 
detected are displayed

Unit not detected list:●●
When scanning was performed for the 2nd 
and subsequent times, displays the units 
which are already registered and were not 
detected this time.

5

As a result of performing scan, a unit of the same address may be displayed in the Unit Newly Detect-●●
ed list and Undetected Unit list.
This occurs when a registered unit was changed to a different model and set to the same address as 
the previous unit, etc.
Since the registration information of the previous unit is erased when registration is completed, con-
tinue at that setting.
When intentionally removing a unit from registration, etc, because the unit is removed from the electric ●●
power charge apportionment objective or other reason, confirm it here. (Perform scanning after turning 
off the power of the unit removed from registration.)

Note

[OK] button: 	 Saves the detected unit configuration detected by scanning.5
[Cancel] button: 	 Ends scanning without saving the scanned result.
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Description Property Setting6666
Values of description properties of all objects within the selected unit can be modified at once.

Select the menu items in order of [Setting]→[Description Property Setting]from the Menu bar.

1

Up to 50 characters can be entered.

2

Click the [OK] button.
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Electricity Charge Apportionment Setting777
Performs basic settings related to electricity charge apportionment necessary before operation. You may 
also update the settings due to facility and tenant changes.
At initial starting after installation, perform setting in accordance with the following flow. For settings and 
changes after operation starts, perform the necessary settings in accordance with the contents of par. 7-2 
and subsequent paragraphs.

Basic Setting Flow7777
Perform initial setting in accordance with this flow.

7-2	 Understand electricity charge apportionment and confirming caution items.

• Use WriteProperty Service to write the command value at the Present _Value property of the MO 
0100000 object from B-OWS.

1:When ending electricity charge apportionment data collection
2:When starting electricity charge apportionment data collecting by calculation including indoor 

units
3:When stating electricity charge apportionment data collection by calculation not including in-

door units

• Use ReadProperty Service or ReadPropertyMultiple Service from B-OWS to read the value of 
Present_Value property of the MI 0200000(ECA Status) object and confirm that it is “2”.

7-3	 Model name setting
	 Set all the places where Model Name of the main screen is displayed in red.
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Overview7777

Purpose of electricity charge apportionment111
The electricity charge apportionment function apportions air conditioner electricity charges to tenants. 
Generally, indoor units are divided among and used by each tenant, and calculation of the electricity 
charge for each tenant is easy. But since outdoor units are shared by multiple tenants, calculation of 
the electricity charge for each tenant is not easy. 
The electricity charge apportionment function allows distribution of the electricity charges of outdoor 
units, which are a large part of the air conditioner power consumption, according to the air conditioner 
usage of each tenant.

Features of electricity charge apportionment of BACnet Gateway222
Power meter is not used and electricity apportionment calculation is performed from the electricity ((((
charges billed from the electric power company.
Apportionment calculation is performed according to indoor unit usage.((((
In addition to electricity charge calculation of outdoor units only, electricity charge calculation ((((
including indoor units is also possible.
Flexible definition according to the electricity charge contract configuration, block configuration, ((((
and usage period is possible.
Since the data for 1 year is saved, recalculation of the past is possible.((((

Precautions for Using Electricity Charge Apportionment Function333
The electricity charge apportionment function requires correct setting and use in accordance with ((((
the descriptions in this manual and Interface Specification Manual. 
If correct operation based on correct setting is not performed, a reasonable result may not be 
obtained.
The electricity charge apportionment function does not calculate official electricity charges like ((((
those established by the laws and regulations of each country.
Gaining an understanding of the descriptions, etc. in this manual and using the electricity charge ((((
apportionment function accordingly should be performed by the responsibility of the user.
The electricity charges used in electricity charge apportionment calculation should only be that of ((((
the power consumed by the air conditioner.
For the electricity charge apportionment function to function properly, BACnet Gateway must op-((((
erate continuously. If BACnet Gateway is shut down or stopped by a power failure, etc. while the 
data needed by calculation is being acquired, correct electricity charge apportionment calculation 
may be not be possible.
Electricity charge apportionment is performed for units identified by scanning. When the unit con-((((
figuration is changed, perform scanning to re-identify the target units.
Constantly maintain the units which are the target of electricity charge apportionment calculation ((((
in the normal operating state. 
If it is turned off for a long time, etc., data acquisition and correct calculation may not be possible.
The electricity charge for units or refrigerant systems which are the target of electricity charge ap-((((
portionment calculation are calculated even when it is turned off. To remove them from electricity 
charge apportionment calculation, turn off the power of the unit or refrigerant system which is to 
be removed and re-scan to remove the unit from the calculation target. 
Electricity charge apportionment calculation identifies units by address. When the address of a ((((
unit was changed by automatic addressing function, etc., perform scanning to re-identify the cor-
rect address. 
Even when an indoor unit operation time is zero, the rate (proportion) of the electricity charge ap-(((((
portionment is not zero because of the power consumed in the outdoor unit in standby. 
The apportionment calculation for the electricity charge cannot be performed for air conditioners (((((
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other than VRF, such as single split type, that are connected to the VRF System via convertors. 
The S/V series and V-II series adopt different refrigerant system control and the electricity charge (((((
apportionment function adopts different method reflecting the difference. So the same operation 
condition for units may not yield the same result for S/V and V-II series. 

BACnet Gateway

V-II-VRF  
System0

Outside the calcu-
lation objective

Outside the calcu-
lation objective

Apportionable range

Electricity charge calculation units Network Converter
(UTR-YRDA)

Network Converter
(UTY-VGGX)

Piping

V-II-VRF  
System1

S/V-VRF  
System

VGGX

YRDAV-II-VRF System

S/V-VRF System

S/V

V-II-1

V-II-2

V-II-3
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Model Name Setting7777
Model Name is automatically acquired at scanning.
When the data was collected normally, Model Name is displayed at "Model Name" and "Model Name for 
ECA".
When the data could not be collected normally, Model name is displayed in red. In this case, set Model 
Name individually.

S/V Series cannot obtain Model Name even by scanning. (This function cannot be used.)**

Select the menu items in order of [Setting]→[Model Name Setting]from the Menu bar.

1

Select "Model Name".

2
3

Click the [OK] button.



8.	 Operation

Operation
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Operation888

Starting and Ending the BACnet Gateway8888
Starting the BACnet Gateway��

Make sure that USB Adaptor Connections (Refer to "5-2 Hardware Installation".) are completed and the 
Ethernet cable for the BACnet Gateway is connected to LAN port of the PC before starting up the appli-
cation.

Select "BACnet Gateway for VRF System" from the Windows start menu.



When "BACnet Gateway for VRF System" boots up, 
the main screen is displayed.

Ending the BACnet Gateway��

Select the menu items in order of [File]→[Exit] from the Menu bar


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Main Screen8888

Menu bar

Tool bar

Status bar (When an error occurs, the error message "In Error"is displayed.)

A

B C D E F

This software has the following functions 

Menu bar (Command name) Contents Tool bar

1 File
Import / Export

Unit List(EDE)  
Export

Exports “Unit List(EDE)” data to a CSV format 
file. -

All Data Import Imports the data backed up by [All Data Ex-
port]. -

All Data Export Backs up the internal data. -
Exit - The BACnet Gateway ends. -

2 View

VRF System

All (All adaptors)
Displays the Status information of all the 
indoor units or outdoor units connected to this 
system.

E

Adaptor*

Displays the Status information of the indoor 
unit or outdoor unit of the selected adaptor.
* A maximum of 4 adaptors can be connected. 
Menus for only the number of connected 
adaptors are displayed

E

Unit

Indoor Unit
Displays the Status information of the Indoor 
Unit connected to the adaptor selected by [VRF 
System] menu.

F

Outdoor Unit
Displays the Status information of the Outdoor 
Unit connected to the adaptor selected by [VRF 
System] menu.

F
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Menu bar (Command name) Contents Tool bar

3 Control

Operation Setting -

The following setting screen of indoor unit is 
displayed.
Operation on/off
Operation mode switching
Set temperature switching
Fan speed switching

(Outdoor Unit cannot be set.)

D

Device Communication 
Disable (*1) -

Device communications is disabled.
* When this setting is performed, communica-
tion with the VRF System is not stopped.

A

Device Communication 
Disable_Initiation (*1) -

The initiation of communications is disabled.
*When this setting is performed, communica-
tion with the VRF System is not  stopped.

B

Device Communication 
Enable (*1) - Communications is enabled. C

Out of Service False Set Out_Of_Service properties of all BACnet 
objects to "False". -

4 Error
Error Notification - Displays the current error information. -
Error History - Displays the error information history. -

5 Setting

Initial Setting -

Set when installing equipment.
Refer to par. 6. Basic Settings.

-
Adaptor Setting - -
Unit Registration - -
Model Name Setting - -
Description Property  
Setting - -

6 Help

Manual - Instruction manual (this manual) is displayed. -
Interface Specification 
Document - Interface Specification Document is displayed. -

Version Information - Version information is displayed. -
About Device Communication Control Service	  ****
The 3 functions "Device Communication Disable", “Device Communication Disable_Initiation" and "Device Com-
munication Enable" can be set for a Device itself. (Time Duration, Password cannot be set) This setting can be 
set from a BACnet Device (B-OWS, etc.) This value can be overwritten from B-OWS.

VRF System0

VRF System1
PC

(BACnet Gateway)
BACnet Device
(B-OWS, etc.)

VRF System2

VRF System3
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Data Import/Export8888

Unit List (EDE) Export888888

Description of function111
Export “Unit List(EDE)” data to a CSV format file.

About “EDE”
The contents of “EDE “ sheet and “State-Texts” sheet of The Engineering Data Exchanger (EDE) 
template created by BACnet Interest Group Europe is output in CSV format. In addition, the “settable” 
field of the “EDE” sheet is not used.

Operating procedure222
Select the menu items in order of [File]→[Import/Export]→[Unit List (EDE) Export] from the Menu bar.

1

Specify the Export destination folder and click [OK]. 
The folder to be saved shall be created in advance.

2

When [OK] is clicked, the export is complete.

3
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All Data Import888888

Description of function111
Import the data backed up by [All Data Export].

Operating procedure222
Select the menu items in order of [File]→[Import/Export]→[All Data Import] from the Menu bar.

1

Specify the file to be imported and click [OPEN].

2

When [OK] is clicked, the import starts.

3
When [OK] is clicked, the import is complete. 
After the main screen is closed, restart BACnet Gateway.5



54
Copyright© 2010 Fujitsu General Limited. All rights reserved.

O
pe

ra
tio

n

All Data Export888888

Description of function111
Back up the "All Data"(internal data).
All Data : Connected U10 USB Network Interface adaptor data, scanned unit data, and data set by B-

OWS.

Operating procedure222
Select the menu items in order of [File]→[Import/Export]→[All Data Export] from the Menu bar.

1

Specify the export destination folder and click [OK]. 
The folder to be saved shall be created in advance.

2

When [OK] is clicked, the export is complete.

3



55
Copyright© 2010 Fujitsu General Limited. All rights reserved.

O
pe

ra
tio

n

View8888

Description of function111
The Indoor unit and Outdoor unit Status information can be viewed.

Operating procedure222
Select the VRF System ([All] or [Adaptor*]) that you wish to display.
Menus for only the number of connected adaptors are displayed**
Select the menu items in order of [View]→[VRF System]→[All or Adaptor*] from the Menu bar

1

Select the displayed unit (indoor unit or outdoor unit).
Select the menu items in order of [View]→[Unit]→[Indoor Unit or Outdoor] from the Menu bar

2

Example) When set to [All] and [Indoor unit]

Items displayed in the Status List.333
I.U.=Indoor unit    O.U.=Outdoor unit

Items Remarks I.U. O.U.
R.C.Group Name Remote controller group name  -
Unit Group Name Outdoor group name - 

System Type Displays the type of refrigerant system  
(cooling only , heat pump or heat recovery)  

Adaptor Name Connected U10 USB Network Interface adaptor name.  

Address

Displays the address for each unit. Display contents: "Refriger-
ant system address "-"Unit address"-"R.C address".
For V-II series following notations apply for the address suffix to 
show how the units are controlled in AUTO mode;

/m  master indoor unit
/s   slave controlled by master indoor unit
/o   unit controlled by outdoor unit

Those without suffixes are units that not any of the aboves.

 
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Items Remarks I.U. O.U.

Model Name

Unit model name*
*The letter ":" as the last letter of the Model Name signifies that 
the Model Name for the corresponding unit was written after 
shipment.  
The letter ":" is not part of the Model Name.

 

Model Name for ECA Model names used with electricity charge apportionment  
Description Explanation for Indoor/Outdoor units  
Capacity Capacity of Indoor units 
Operation Status Operation Status  -

Type Indoor unit type
*Universal shows Floor or Ceiling.  -

OP Operation status.  -

MODE Displays the operation mode. 
(Displayed even when stopped.)  -

SET Temp. Set Temp. (°C) Displays the set temperature.  -
Fan Speed Fan speed displays the air flow setting.  -

Reliability Shows any of the values other than "No_Fault_Detected",of the 
reliability properties of the objects contained in the unit.  

Out of service Shows "True" if any one of the values of the Out_Of_Service 
properties of the objects contained in the unit is "True".  

Error State separate from original instruction and operation  
Code Error code of current error  
Contents Error code details  
Time of Occurrence Time error occurred  
Total Count of  
Occurrences Number of errors which occurred from start up to the present  

Emergency Stop Displayed when emergency stop signal sent/received  

Priority Operation Mode Cooling/heating priority operation  
(Heat pump of S/V Series only) - 

Control8888

Operation Setting888888

Description of function111
Indoor unit “On/Off”, “Operation Mode”, “temperature setting”, and “Fan speed” can be set.

Operating procedure222
Select indoor unit.
Select the menu items in order of [View]→[Unit]→[Indoor Unit] from the Menu bar

1
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Click the unit (line) that you wish to select.

2

Select the menu items in order of [Control]→[Operation Setting] from the Menu bar
or

Click the D  button.

3

D

"Operation Setting"screen is displayed.
When the set button is pressed, “On/Off”, “Operation Mode”, “temperature setting”, and ”Fan speed” 
can be set.
Function which cannot be set is not pressed.**

"Reset" button: When this button is 
pressed, returns to the setting state 
when this screen was displayed.




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Function List

On / Off Switches operation of the selected Indoor Unit On/Off.
Operation Mode Switches Operation Mode to [Auto], [Cool], [Dry], [Fan] or [Heat].
Set Temp.(˚C) Changes the set temperature.
Fan speed Switches Fan speed to [Auto], [Low], [Med] or [High].

Click the [Send] button.5
Indoor unit setting is switched. 

Device Communication Disable888888

Description of function111
Device communications is disabled.
When this setting is performed, communication with the VRF System is not stopped.**

VRF System0

VRF System1
PC

(BACnet Gateway)
BACnet Device
(B-OWS, etc.)

VRF System2

VRF System3

Operating procedure222
Select the menu items in order of [Control]→[Device Communication Disable] from the Menu bar

or
Click the A  button.

A

1

Click the [OK] button on the window of "Disable device communication" shown below.

2



59
Copyright© 2010 Fujitsu General Limited. All rights reserved.

O
pe

ra
tio

n

Device Communication Disable_Initiation888888

Description of function111
The initiation of communications shall be disabled.
When this setting is performed, communication with the VRF System is not stopped.**

Operating procedure222
Select the menu items in order of [Control]→[Device Communication Disable_Initiation] from the Menu 
bar

or
Click the B  button.

1

B

Click the [OK] button on the window of "Disable initiation of communications" shown below.

2

Device Communication Enable888888

Description of function111
Communications is enabled.

Operating procedure222
Select the menu items in order of [Control]→[Device Communication Enable] from the Menu bar

or
Click the C  button.

1

C
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Click the [OK] but on the window of "Enable device communications" shown below.

2

Out of Service888888

Description of function111
Set Out_Of_Service properties of all BACnet objects to "False".

Operating procedure222
Select the menu items in order of [Control]→[Out of Service]→[False] from the Menu bar

1

Click the [OK] button on the window of "All objects will be put in service." shown below.

2
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Error8888
“Error information” and “Error History”can be viewed.

Displays Error Information888888

Select the menu items in order of [Error]→[Error Notification] from the Menu bar
or

Automatically opens at error generation.

1

"Error Notification" screen is displayed.

"Error Notification" screen

Items displayed in the ERROR List of Indoor/Outdoor Unit.

Items Remarks
Date Date error occurred

Unit Group
When "Indoor Unit” is selected, “R.C.Group Name” is displayed.
When Outdoor Unit is selected, “Unit Group Name” is displayed.
Otherwise, ""-"" is displayed.

Model Name

Unit model name*
*The letter ":" as the last letter of the Model Name signifies that the Model Name for the 
corresponding unit was written after shipment. 
The letter ":" is not part of the Model Name.

Adaptor Name Connected U10 USB Network Interface adaptor name.

Address Displays the address for each unit. Display contents: "Refrigerant system address 
"-"Unit address"-"R.C address".

Error Code Error code
Contents Contents
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Displays Error History888888

Select the menu items in order of [Error]→[Error History] from the Menu bar
or

Click the [History] button of the "Error Notification" screen.

"Error History" screen is displayed. 

Help8888
"Instruction manual", "Interface Specification Document", and Version information of BACnet Gateway is 
displayed.

Displays “Instruction Manual”888888

Select the menu items in order of [Help]→[Manual] from the Menu bar

1

"Instruction manual"(this manual) is displayed.

Displays “Interface Specification Document”888888

Select the menu items in order of [Help]→[Interface Specification Document] from the Menu bar
"Interface Specification Document" is displayed. 

Displays Application Version Information888888

Select the menu items in order of [Help]→[Version Information] from the Menu bar
"Version Information" is displayed.



9.	 Product Specifications
10.	Error Code Table
11.	FAQ
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Product Specifications999
Operating Conditions9999

BACnet Gateway

Model name UTY-ABGX

OS Microsoft® Windows® XP Professional (English version) Service pack 3 or later
Microsoft® Windows Vista® Home Premium, Business (English version) 

CPU Intel® Pentium®/Celeron® 2 GHz or higher

Memory 2GB or more

HDD 40GB or more of free space

Display (resolution) 1024 x 768 pixel or more

Interface
USB (Ver.1.1/2.0) port x 1 (for WIBU-KEY) 
USB (Ver.1.1/2.0) port x 1 to 4 (for U10 USB Network Interface)*
Ethernet Port

Number of USB ports required differs with the number of adaptors connected.**

Accessories9999
CD-ROM (Application and Manual)...................................................................................... (1)
USB Software Protection key............................................................................................... (1)
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Error Code Table1111
The BACnet Gateway error codes are shown below. When an error occurred at the BACnet Gateway, 
check the codes below and contact your service personnel.
Refer to the Interface Specification document for the Indoor unit and Outdoor unit error codes.

Error code Error contents

F11 Database access error

F12 Database connection error

F13 Software restart error

F14 Program run time error

F15 Error at execution of various special operations

F16 Insufficient vacant space on HDD used by database

F21 Transmission adaptor connection failed

F22 Transmission error (data not acquired)

F23 External input power meter error

F31 Communication between processes error

F32 Software protection key not recognized (including WIBU-KEY obstruction)

F33 Server/client communication error

F41 HDD capacity error

F42 System requirements error

F43 Time error
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FAQ1111
General11111

No.
Question

Answer

1.

The PC power was dropped during unit scanning. What happens to the data scanned up to the point?  
Is data integrity maintained?

The scanned data is saved when scanning is completed and the [OK] button is pressed.
When the power was dropped before this, the data scanned up to that point is lost. Restart scanning from 
the beginning. 		  → 6-5 Unit Registration.

2.

When scanning, U10 USB Network Interface is not displayed as a selection choice. What should I do?

U10 USB Network Interface driver is not installed.
Install the OpenLDV supplied with the U10.
Power is not supplied.
If an USB hub is used or many USB units are connected, the power supply may be insufficient. Connect 
the USB units directly to the PC, or reduce the number of USB units connected.

3.

Can the U10 USB Network Interface used with the BACnet Gateway also be used with service tools and 
other software?

The adaptor can also be used with service tools. However, one adaptor cannot be used simultaneously by 
the BACnet Gateway and service tools.

4.

What is the difference between Secure Reg enable and disable at Unit Registration?

Secure Reg. is a mode which stops operation of all the units and confirms scanning for Unit Registration. 
Secure Reg. disable is a mode which performs scanning in parallel without stopping operation of the units.
Since scanning is an important function for recognition of the units to be managed by the BACnet Gate-
way, it is recommended that, as a rule, it be performed by enabling Secure Reg. If unavoidable, disable 
Secure Reg only when scanning must be performed without stopping operation of the units. In any case, 
whether or not units were recognized correctly must be confirmed after scanning. However, when scan-
ning was performed with Secure Reg disabled, re-scanning may be necessary due to Unit Registration 
failures.

5.

Scanning was performed, but all the units were not recognized. What should I do?

When work is performed normally and scanning is performed after confirmation and units are not recog-
nized, first check that the power of the unrecognized units is turned on.
Other causes may be:
	 •Unit trouble
	 •Installation work problem
	 Contact your service parsonnel.

6.

Scanning was performed, and all the units were recognized, but R.C. group information is not correct. 
What should I do?

They may be an abnormality in the wiring which defines the R.C. group or incorrect setting of the address 
in the indoor unit R.C. group. Refer to the service manual and perform setting correctly.

7.

Scanning was performed and all the units were recognized, but the unit information is not correct. 
What should I do?

It is possible that communication with the unit is incomplete. 
Enter a secure reg. check mark and re-scan.	 → 6-5 Unit Registration.

8.

Scanning takes a very long time. What can I do?

When the existing refrigerant system numbers are known in advance, the scanning time may be short-
ened by specifying the refrigerant range to be scanned at the scan execution screen. For example, when 
rescanning, etc. when recognition by scanning isn’t very good, the scanning time can be shortened by 
specifying the range of only the refrigerant systems at which recognition was poor. In addition, scanning 
by “secure reg.” is faster than scanning “without secure reg.”.	 → 6-5 Unit Registration.
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No.
Question

Answer

9.
I want to replace the PC with a new PC. Can the data be transferred?

The BACnet Gateway has data Export and Import functions.
For details, see the Import/Export page.

10.
Unit expansion, replacement, and removal were performed. How can I reflect these changes at the 
BACnet Gateway?

Perform scanning again.	 → 6-5 Unit Registration.

11.
VRF System expansion, replacement, and removal were performed.

After setting the U10 USB Network Interface adaptor correctly, recognize the units by scanning.
→ 6-2 Initial Setting , 6-4 Adaptor Setting, 6-5 Unit Registration

12.
The state displayed on the screen does not change even though operation setting is performed.

When operation setting was performed at multiple units or at a group containing multiple units, it may take 
some time for the state of that unit to change to the set contents.

13.
Can a transmission adaptor (UTR-YTMA) be used with the BACnet Gateway?

Transmission adaptor (UTR-YTMA) cannot be used with the BACnet Gateway.

14.
Can a WIBU-KEY used by a UTR-YLBA be used by the BACnet Gateway?

Since the UTR-YLBA and BACnet Gateway are separate products, the WIBU-KEY used by the UTR-YLBA 
cannot be used by the BACnet Gateway.

15.
 Can a XLON® used by a UTR-YLBA be used by the BACnet Gateway?

No. it cannot be used.

16.

Installation of “MSXML6” and “SQL Server Database Services” failed in the “Microsoft SQL Server 2005 
Express Setup” process, during the installation of BACnet Gateway. What should I do?

To work around this issue, use the “Windows Installer Clean Up utility” to remove references to MSXML 6.0 
Service Pack 2. To do this, follow these steps: 
1. Download the “Windows Installer Clean Up utility”. To do this, visit the following Microsoft Web site:
    http://support.microsoft.com/kb/290301
2. After installation, run the “Windows Installer Clean Up utility”.
3. Select MSXML6 Service Pack 2 (KB954459) [6.20.1099.0] in the list, and then click Remove.
4. After restarting the Windows, install the BACnet Gateway again. 
    Reference: http://support.microsoft.com/kb/968749

17.

Warning message appeared saying that “SQL Server cannot install files to the compressed or encrypted 
folder … “, while performing “Microsoft SQL Server 2005 Express Setup” process, during the installation of 
BACnet Gateway. What should I do?

When the folder in the “Program Files” folder where the “Microsoft SQL Server 2005 Express” is to be 
installed is compressed or encrypted, “Microsoft SQL Server 2005 Express” cannot be installed. 
Undo the compression or encryption of the “Program Files” folder where the “Microsoft SQL Server 2005 
Express” is to be installed, as follows. 
1. Start “Windows Explorer”. 
2. Right-click on the “Program Files” folder, select “properties”. 
3. Click “Advanced...” button. Remove the check for “Compress contents to save disk space” and “Encrypt 

contents secure data” of “Compress or Encrypt attributes” and press “OK”. 
4. Click “OK” in the “property” of 2 and undo operation is executed for the item where the check has been 

removed in 3. Do not perform any operation on the Windows while this operation is in progress. The 
duration of the operation depends on the volume of the folder. The time given on screen gives a rough 
estimation.

18.

Why is an electricity charge generated even though none of the indoor units is being used?

Since power is consumed by the outdoor unit even when all the indoor units are not in use, an electricity 
charge is generated.
To prevent generation of an electricity charge, turn off the power of that indoor unit and perform scan to 
remove the indoor unit from the electricity charge apportionment function objectives.
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19.

Why isn’t the operation time and electricity charge proportional?

If the room temperature has reached the set temperature even if the operation is turned ON by a remote 
controller, the indoor unit will not operate and the power consumption will be that much lower.
In addition, if the difference between the room temperature and the set temperature is large, more power 
is consumed than when the difference is small. Therefore, the operation time and electricity charge may 
not necessarily be proportional.

20.

Why is the electricity charge of operated indoor units so much smaller than that of indoor units that are not 
operated at all?

Electricity charge includes the power consumed by the outdoor unit in addition to that of the indoor unit. 
The outdoor unit consumes power constantly so that operation at any time is possible even though indoor 
units are not operating. This is called the "standby power". Since the standby power differs between the 
models of outdoor units, if the number of indoor units per outdoor unit is assumed to be the same, the 
indoor units which use an outdoor unit will consume more power than indoor units which use with high 
standby power.
This question is an example of when the difference of this standby power was larger than the power con-
sumed by operation. This is a normal result. Generally, this kind of difference is made small by selecting 
the model of outdoor unit based on appropriate facility design.

21.

Why has the electricity charge suddenly increased even though the use is the same as in the past?

One of the reason could be that some tenants have moved out. The electricity charge is apportioned 
between blocks. When the number of blocks decreases or increases by moving in and out of tenants, the 
electricity charge increases and decreases. As an example, if the basic charge is set so that it is equally 
apportioned between the blocks, then the electricity charges decreases if tenants move in and increases if 
tenants move out. The building owners and managers should perform appropriate settings in accordance 
with his/her policy as to how things should be in such cases.

22.

Characters displayed on the screen are strange. What should I do?

Region is not set.
Refer to "5-3 Regional Setting" and set the region.
OS or PC trouble
Contact the manufacturer of your PC.
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Trouble Shooting BACnet Installation11111

Trouble Shooting Procedures
If you can not perform monitorings and controls of VRF system form B-OWS, the first step for the trouble
shooting is to localize the trouble.

Q3.Can the VRF system be monitored and controlled by Service Tool?

Communication OK?

Service Tool (UTY-ASGX)

Q2.Can the VRF system be monitored and controlled by BACnet Gateway?

Q1.Can the VRF system be monitored and controlled by B-OWS?

B-OWS : Operator Workstation, workstation used in the building management system.

VRF System
BACnet Gateway B-OWS

Answer each questions in the diagram to see what sort of troubles are suspected.

Q1.Can the VRF system be monitored and controlled by B-OWS?
If no, any of the troubles below is suspected;
S1)VRF system is faulty or is not setup properly.
S2)Communication between BACnet Gateway and VRF system is not normal.
S3)BACnet Gateway is faulty or is not setup properly.
S4)Communication between the B-OWS and BACnet Gateway is not normal.
S5)B-OWS is faulty or is not setup properly.

Q2.Can the VRF system be monitored and controlled by BACnet Gateway?
If no, any of the troubles below is suspected;
S1)VRF system is faulty or is not setup properly.
S2)Communication between BACnet Gateway and VRF system is not normal.
S3)BACnet Gateway is faulty or is not setup properly.

Q3.Can the VRF system be monitored and controlled by Service Tool?
If no, the trouble below is suspected;
S1)VRF system is faulty or is not setup properly.

For each of the troubles suspected, perform the following checks to identify the problem.

S1.VRF system is faulty or is not setup properly.
If the VRF system itself is not working properly, consult the the Service Manuals for VRF system.

S2.Communication between BACnet Gateway and VRF system is not normal.
If the communication within the VRF system is not working properly, consult the Service Manuals for
VRF system.
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S3.BACnet Gateway is faulty or is not setup properly.
Refer to the Instruction Manual (this manual) of BACnet Gateway.
See also A1.Initial setting for PC.

S4.Communication between the B-OWS and BACnet Gateway is not normal.
See A2.Networking Troubles.

S5.B-OWS is faulty or is not setup properly.
Refer to the manual that comes with the B-OWS.
Be sure that settings are correct for connecting with the BACnet Gateway.

A1:Initial Setting for PC
Network Setting for the PC((((
Perform appropriate setting for the transparent connection of UDP/IP unicast and multicast communi-
cation.

IP Address / Netmask Setting●●
UDP port 0xBAC0(47808) made available and enabled●●

A2:Networking Troubles
Checking Unicast Communication((((
Ping to/from BACnet Gateway – B-OWS using Windows Command Prompt.
Ex. “Ping 192.168.16.2”
If you get the response, unicast is reachable.
Checking Broadcast Communication((((
Trace route to/from BACnet Gateway – B-OWS using Windows Command Prompt.
Ex. “Tracert 192.168.16.2”

Troubls Shooting the Interworking Troubles
BACnet is an open network protocol interpreted and implemented by different vendors.
In some occasions, you may encounter interworking troubles.
If the trouble could not be located in the procedures above, interworking troubles may be suspected.

Analyzing interworking troubles involve capturing BACnet communication packets and analyzing the
protocol using tools (ex.Wireshark) and expertise on BACnet.

Followings are some hints on the checks you need to perform in order to trouble shoot interworking prob-
lems.

Has B-OWS recognized BACnet Gateway?111
If the B-OWS does not recognize BACnet Gateway, then the initial setting may be wrong or networking 
problem is suspected.

Has B-OWS established connection to the BACnet Gateway?222
If the B-OWS cannot establish connection with BACnet Gateway (eg.B-OWS has issued error after 
series of communication), then packets must be captured to see where and what has gone wrong.

Has B-OWS registered units in VRF System correctly?333
If the B-OWS cannot register units in VRF System correctly, then registration must be checked first 
using BACnet Gateway user interface. If there are no problems on the BACnet Gateway, then packets 
must be captured to see where and what has gone wrong.

What Service is Malfunctioning?444
If any service cannot be performed on the B-OWS, then packets must be captured to see where and 
what has gone wrong.
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